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Introduction
‘Data’ are the ‘raw materials’ of a field or laboratory research activity.  This is generally an experiment, a survey or a monitoring exercise.  These are the numbers resulting from measurements, the responses to questions and the information about where they came from.  ‘Data Management’ is a generic term for any activity concerned with ‘looking after’ and processing this information.  
Data management is an essential consideration in any research and, if not done well, can severely limit the usefulness of the data.  The objective of data management is to maximise the value of data.  A good data management system leads to:

1. Improved data quality

2. Improved data access

3. Improved data processing efficiency

Unless we can guarantee the quality of our data, then the results of analyses and the subsequent conclusions would be at best dubious and at worst wrong.  Erroneous answers damage the reputations of both the individual researcher and his/her organisation and does not help to solve the original research problems.

Data is expensive to collect and it is therefore essential to get as much out of it as possible.  This involves increasing its lifespan so that others, both now and in the future, can benefit from it.  To make this possible we need to maximise data access.  This involves both producing clear data documentation and maintaining up to date lists of where the data are to be found – i.e. who currently controls the master copies.  Remember the dataset itself is a key output from any research project.

Preparing datasets for analysis is often very time-consuming and, if a lot of manipulation is involved, can result in errors creeping into the data.  A good data management strategy will include the use of software and data formats that improve the ease and speed of data processing.

The Research Methods Group at ICRAF in Nairobi have been working in areas of research quality and data management to help researchers to maximise the value of their data.  The Logbook data management toolkit, available from the Research Methods Group, helps scientists improve data processing efficiency by storing data in a well-structured database and provides tools for extracting subsets of the data for analysis.  It includes a user-friendly front-end, known as the Logbook Assistant, for navigating the database.  This is described in the Logbook Users Manual – also available from the Research Methods Group.

Closely related to Logbook is the Data Publishing system which primarily addresses the issues of data access.

So what is Data Publishing?

Data Publishing is a data management tool that uses web-enabled technology to catalogue research data so that they are meaningfully shared during the life of a project and long after it has closed.  Here we are not just talking about “data” files in the traditional sense – i.e. rows and columns of numbers – but also project proposals, protocols, reports, syntax files, and often even photos.  These are all “data” in the wider sense, commonly known as “meta-data” as they help to more fully describe the project and the data and give a more complete picture.

There is usually no central repository for these files and often they are spread among the researchers for a project, often on different computers and sometimes secreted in obscure locations on personal computers.  Even when a researcher is highly organised with their own folder structure it is often difficult for others to find files on their PC due to clueless file/folder names and implied relationships that are difficult to discern from the folder structures.  It is also true that, even with a well-organised folder structure, there are often files that could logically fit into two or more locations, a problem often solved by creating multiple copies of the same file – thus making the problem worse.
Basically a typical organisation will have thousands of data files scattered among numerous PCs and they are less useful than they should be because their accessibility it less than optimal.  This is a physical data access problem which has in part been solved by the intranet/internet.  However, there still remains the logical access problem – what use are the data if you cannot understand them.  This is the problem that data publishing is attempting to solve.  

Others have tried to solve this problem in the past; for example the Windows Indexing Service and the Google Desktop system both exploit full-text indexing of files on desktop PCs.  However, these only retrieve files containing searchable text, leaving out files that contain just numbers and binary data.  These systems are therefore fine for the data documentation files but do not work on the raw data files.  

Others have tried human-maintained catalogues.  These only tend to work if everyone in the organisation provides regular and up-to-date information to a central repository.  This may be adequate for smaller organisations but are unlikely to work for larger organisations which generate lots of data from many remote computers. 
The data publishing tool was developed to address these problems.  The system makes use of File Properties which are stored with the file but not as part of the file contents.  Thus, even for a raw data file containing just numbers, you can attach detailed information which can then be searched using the data publishing system.  Using file properties set the individual researchers, data publishing “harvests” information about the files and produces lists that can be browsed and searched based on a number of different criteria.  For example you could list all files containing concept notes, or all files associated with a particular project; you could list all files containing data on maize yields; etc.  These lists can be “published” on either the local machine or on an intranet.  This helps both the individual researcher and the organisation to organise their files and makes finding files quick and easy leading to efficient and effective data management.  It is also possible to view file contents.  

Note: individuals have complete control over whether or not to “share” their files and who can have access to them.  Thus you can choose whether or not to include your files in the published lists.  Others cannot access your files unless you give them permission.  Chapter 2 covers everything you need to know about sharing your files and folders.
Figure 1 below shows an example “published list” of files.  This example is taken from the tutorial later in this manual.
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Figure 1: Published list of protocols

The list is viewed using Internet Explorer.  The screen is divided into two panels – the left-hand panel shows different methods of viewing the “data” – the right-hand panel shows a table with information about each file.  The image in Figure 1 shows all the protocols from the harvested files.

Data Publishing Users

We recognise that there are potentially three types of user for the data publishing system:

Type 1: 
A type 1 user is a researcher who views published lists by linking to a server.  The lists are likely to include his/her own shared files plus shared files from others within the organisation.  The user sets file properties, shares the folders containing the files to be included in the lists and informs the data manager that he/she has data to be published.  The data manager does the “harvesting” and lets users know which URL to use in Internet Explorer to access the published lists.  For type 1 users there is a separate document called “Data Publishing – Getting Started Guide” which covers much the same material found in Chapters 1 and 2 in this manual.
Type 2:
A type 2 user is one who is looking to publish lists of his/her own files on his/her local machine.  This helps users to organise their own files better.  Type 1 and type 2 are not mutually exclusive – a researcher may be happy to have some of his/her work shared and published on the server, but might also have some more confidential work that he/she prefers to view only on the local PC.  The tutorial later in this manual goes through the process of publishing to the local machine.

Type 3:
Type 3 users are those who harvest files from several PCs and publish the lists on the server.  These are generally data managers or IT support staff.  There will be a separate guide for data managers detailing some of the more technical aspects of data publishing and how the system works.

The main factor distinguishing the types of users are:

a) Those that generate and use the data;

b) Those that need to know how to configure folder sharing and internet information settings.  

Some chapters are more relevant for (a) and others for (b).
Data Publishing through the Logbook Assistant
For the data publishing system a “publish” database stores the information harvested from the file properties.  The Logbook Assistant, part of the Logbook Data Management Toolkit, is used to load the information into the database and can also be used to browse the lists.  Figure 2 shows the same list as seen in Figure 1 but this time viewed using the Logbook Assistant.
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Figure 2: List of published protocols viewed through Logbook Assistant

There are thus two interfaces to Data Publishing.  One (as shown in Figure 1) is based on the web and is important for type 1 users who need to access data through the Intranet.  The second (as shown in Figure 2) is through the Logbook Assistant and is based on a Windows desktop.  This is for users who have to administer the system.

Thus data publishing can be thought of as an extension to Logbook.  The diagram in Figure 3 below shows the link between Logbook and Data Publishing.


[image: image3]
Figure 3: Link between Data Publishing and Logbook

System Requirements

The data publishing system makes certain assumptions about your operating system and file system.  If you are a type 2 user and wish to publish file lists onto your own PC then you are some additions to Windows that will need to be installed.  For these installations you would need to have administrator rights.

In this section we will list the requirements for type 1 users and the additional requirements for type 2 users.  We will also give instructions on how to check the current status of your PC.  We will then give instructions for changing your system to meet the requirements of data publishing.  Given the administrator privileges are needed for many of these changes, you may need to ask your IT support staff for help and may therefore choose to skip over the more technical details.

Type 1 user requirements

Operating System: 

You must have Windows XP with at least Service Pack 2 installed, or Windows 2000 with at least Service Pack 4.  It is strongly recommended that you install all available updates for Windows.  You should also have the full, Professional version of the operating system and not the Home version.   

To check your version of the operating system:

· Go to Start -> Control Panel
· If you have Category view choose Performance and Maintenance then click System.

· If you have Classic view just double-click on the icon for System
This will tell you what operating system you are using and whether you have any service packs installed.  It will also tell you the type and speed of the processor and the amount of RAM you have.  Figure 1 shows an example and is from a PC running Windows XP Professional with Service Pack 2 installed.  The machine has a Pentium 4, 3.00 GHz processor and 0.99 GB of RAM.
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Figure 1: System Properties

File System Type
Your drive must be formatted as NTFS (New Technology File System).  The alternatives are FAT and FAT32 (File Allocation Table).  With a FAT system you would only see the file properties on Excel, Word and PowerPoint files.  See Chapter 1 for more information about file properties.

You need to check the file system type on all your internal hard drives.  You will have a drive C: and you may also have a drive D: (and maybe others).

· Go to My Computer and right-click on the icon for the C: drive.  Choose Properties from the pop-up menu.  Figure 2 shows typical properties from an NTFS drive.
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Figure 2: Properties from an NTFS drive

· Repeat for other internal drives.

Note: Most memory sticks are formatted as FAT.  Figure 3 shows the properties for a typical memory stick.
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Figure 3: Properties from a memory stick formatted as FAT
Networking – Domain or Workgroup
When you connect to the network you would be either part of a domain or part of a workgroup.  A workgroup is a simple grouping of computers intended only to help find shared printers and folders within that group.  A domain is also a group of computers but is administered centrally and offers better security to users.  The options for sharing your folders and setting permissions on your shared folders will differ depending on whether you are part of a domain or a workgroup.  This is covered in more detail in Chapter 2.  If you want your files to be published on a local intranet then you must be part of a domain.

To check whether you are on a domain or part of a workgroup:

· Go to Start -> Control Panel
· If you have Category view click on Network and Internet Connections, then click Network Connections.

· If you are in Classic view, double-click the icon for Network Connections.

· Choose Network Identification from the Advanced menu.

Figure 4 shows the results from two computers – the first is part of a workgroup called SSC and the second is on the domain called rdg-home.
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	Figure 4a: PC is part of a Workgroup
	Figure 4b: PC is on a domain


Domains are local to your organisation so if you need to move to a domain you will need to contact your IT support staff for further information and assistance.

Your computer name

To use data publishing you will need to know the name of your computer.  This is the unique name that has been assigned to your PC for recognition over the network.  It is generally easier to remember than the IP address.  Figure 4 shows the Full computer name which includes the network domain.  The first part of this name is what you need to know to identify your PC.  The PCs in Figure 4 are called snpc41 and snpc239 respectively.
Type 2 user requirements

A type 2 user will need all the system requirements of a type 1 user as well as the following:
MS-Office

It is assumed that most users will have MS-Office.  The version installed must include MS-Access.  Logbook, and therefore also data publishing, has been tested extensively under Access 2003.  It is strongly recommended that all available updates are installed.  The following requirements are based on those given on the Microsoft website for MS-Office:

Hard disk space: You should have at least 400MB of available disk space.

Processor: 266 MHz or higher; Pentium III or higher is recommended.

RAM: 128MB or greater.

Logbook
The Logbook toolkit (version 3) must be installed.  This version of Logbook has the ProactiveShare menu with menu items Steps, Pro-active share and Output study folders.  Figure 5 shows the contents of the ProactiveShare menu and the Steps sub-menu.
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Figure 5: ProactiveShare menu from Logbook

If your version does not have this menu then it is an older version and will need replacing with the latest version.

Note: If you go to Help -> About Logbook this will always tell you it is version 1.0.0
Internet Information Services (IIS)

This is a facility within Windows for helping you to publish information on the Internet or on an Intranet.  It includes a range of administrative features for managing Web sites.  It is not installed by default.  Data publishing users IIS to create “virtual” directories linked to the shared folders containing data to be published.

To check whether you have IIS installed do the following:

· Open Internet Explorer and type //computername into the Address box where computername is the network name of your PC.  

Figure 6 shows the results you would expect if IIS is installed on your machine.
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Figure 6: Internet Information Service is running on machine snpc239

This also gives you a link to the online documentation for IIS for those interested in finding out more about this service.  Figure 7 shows the results from a machine called snpc200 where IIS is not installed.  What you see in your case depends on your default search engine.
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Figure 7: Internet Information Service is not running on machine snpc200
Indexing Service

This is a service for Windows (2000 or later) that extracts content from files and constructs an indexed catalog to facilitate efficient and rapid searching.  Indexing service can extract both text and property information from files on the local machine and on remote, networked drives.  The files can simply be stored on network drives or can be part of a virtual directory under IIS.  To take advantage of the search facility in data publishing, the indexing service must be started on your PC.  By default there is a system catalog containing directories from your local hard drive and, if IIS is installed, there will be a Web catalog linked to the virtual directories that have been created under IIS.  A virtual directory is effectively a link to shared folders on your own PC or on other shared PCs on the Intranet.
A user with administrator privileges can create new catalogs and has control over which folders to include.

To check that the indexing service is started on your machine:

· Go to Start -> Control Panel
· If you are using Category view choose Performance and Maintenance followed by Administrative Tools.

· If you are using Classic view double-click on Administrative Tools
· Double-click on Computer Management
· Click the plus sign next to Services and Applications, and then click on Indexing Service.

Figure 8 shows a system with two catalogs both of which have been started.
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Figure 8: Indexing Service started on both catalogs

For more information about the Indexing Service and how it links to Internet Information Service, look up Indexing Service under the Help and Support on your PC.

Note: You may need to have administrator rights to check the status of your indexing service.

System Preparation and Software Installation
This section is primarily for type 2 and 3 users.  The section is quite technical at times and you may choose to ask your IT support staff for help especially as you are likely to need administrator permissions for most of these installations and changes.

Service Packs and Other System updates
Windows Service Packs and other updates are available via the Microsoft Website.  On the Tools menu in Internet Explorer, there is a menu item – Windows Update – which takes you directly to the Microsoft Update site.  This will search your machine to work out whether or not you have all the latest updates installed.  It then gives you the option to install these updates.

There is also an option to automatically install updates.  For more details about automatic updates search for Automatic Updates under Help and Support or ask your IT support staff.

Updates for MS-Office are also available from the Microsoft Website.

Converting from FAT to NTFS

To convert a drive from FAT or FAT32 to NTFS do the following:

· Open a command prompt – go to Start -> All Programs -> Accessories -> Command Prompt
· In the Command Prompt window type

Convert <drive_letter>: /fs:ntfs

where <drive_letter> is the drive you are converting (generally C: or D).  This will tell you what the current file system is (e.g. FAT32) and ask you to enter the current volume label for the drive.  Windows then runs some checks on the drive and, assuming everything is okay, it will proceed with the conversion.  If the drive is currently in use you will receive a prompt asking if it is okay to un-mount the volume prior to conversion.  If the drive you need to convert is your system drive (generally drive C:) then the system will need to reboot in order to un-mount the drive.  The conversion is done prior to the system restarting.

The conversion does not affect any of your files on the drive but it is always a wise precaution to take a backup before attempting any system changes.

Note: Most memory sticks will, by default, be formatted as FAT.  These can be converted to NTFS using the method described above.

Logbook installation

Logbook version 3 will be available on a distribution CD.  The CD includes the installation files and the files needed for the tutorial.  It is hoped that, once the documentation is complete, the manuals will also be available on the same CD.

The distribution CD includes a setup.exe program.  To install the Logbook toolkit, run this program.  As with most applications you have the chance to specify the folder in which to store the software – the default is C:\Program Files\Logbook.  The set-up procedure will also install Microsoft Data Access Components if they have not already been installed.  During the installation you may receive a message saying that a file being copied is older than the file currently on your system.  In this case you should always choose the option to keep the existing file.

Following a successful installation there should be four sub-folders below C:\Program Files\Logbook (or whichever folder you specified during installation).  These folders are:

bin:
This contains the Logbook Assistant executable file called lb.exe plus some .dll files.
dbase:
This contains the empty MS-Access database file – shell-activity.mdb – which is used for storing and browsing data using the Logbook toolkit.  This use of Logbook is described in the Logbook Users’ Manual.
publish:
This contains .asp (Active Server Pages) files used for data publishing and also an empty copy of the database publish.mdb.

options:
This contains two Excel files which are used by the Logbook Assistant when “harvesting” data for publishing.  These files will need to be customised and there are instructions for customising in Chapter 4 of this manual.
Figure 1 shows the Logbook folders and the contents of the publish sub-folder as viewed through Windows Explorer.
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Figure 1: Logbook folders after installation of the software

In this example the current version of Logbook (version 3) has been installed into the folder Logbook3.  A previous version of Logbook is also installed on this machine and in figure 11 you can see that this older version includes the sub-folder xml.  If your version of Logbook has an xml sub-folder then it is not the latest version.

Note: Type 1 users do not need to install Logbook to use data publishing.  However, all users can make use of the Logbook toolkit for managing and storing their data.  See the Logbook Users’ Manual for more information.

Internet Information Services (IIS)
To install IIS:

· Go to Start -> Control Panel -> Add or Remove Programs.

· Choose Add/Remove Windows Components – the third items in the panel on the left hand side.

· In the dialog box for the Windows Components Wizard find Internet Information Services in the list of components and click the check box, then click Next.  This should proceed with the installation and you click Finish when it is completed.

Installation Problems

On some machines you may be asked for the Windows XP Service Pack 2 CD during installation of IIS.  This could be a problem in itself especially if you have been installing updates directly from the Microsoft Website and therefore don’t have a copy of the CD.  In this case contact your IT support staff who hopefully will have a copy of the CD or at least an image of it and will therefore be able to help you.  Failing that you can order a copy directly from Microsoft.

Another problem you may encounter is that you receive a message saying something like “Setup cannot copy the file Staxmem.dll”.  This is a known problem and Microsoft have issued a solution on their Website.  This solution is duplicated here for your benefit.
	Resolution to known IIS installation problem 
[image: image14.png]


To resolve this issue, first run the Esentutl.exe tool to examine the integrity of the Secedit.sdb database. To do this, follow these steps: 

1.

Click Start, click Run, type cmd, and then click OK.

2.

At the command prompt, type the following command, and then press ENTER: 

esentutl /g Drive:\WinDir\security\database\secedit.sdb
Note In this command, Drive is the hard disk drive where Windows XP Professional is installed, and WinDir is the folder where Windows XP Professional is installed.

After the Esentutl.exe tool finishes, use one of the following methods to resolve the issue, depending on the message that the Esentutl.exe tool returns: 

•

If the Esentutl.exe tool returns the following message, use Method 1 to resolve the issue: 

This operation may find that this database is corrupt

•

If the Esentutl.exe tool returns information that is similar to the following message, use Method 2 to resolve the issue: 


Microsoft(R) Windows(R) Database Utilities 
Version 5.2 
Copyright (C) Microsoft Corporation. All Rights Reserved. 

Initiating INTEGRITY mode... 
Database: L:\WINDOWS\security\database\secedit.sdb 
Temp. Database: TEMPINTEG2680.EDB 

Checking database integrity. 

Scanning Status (% complete)
0 10 20 30 40 50 60 70 80 90 100 
|---|---|---|---|---|---|---|---|---|---| 
................................................... 

Integrity check successful. 

Operation completed successfully in 0.841 seconds. 

Note When you run the Esentutl.exe tool, your computer is returned to the original installation state where the Local Security Policy is not defined. You may have to start your computer in Safe Mode to rename files or to move files. To start your computer in Safe Mode, press the F8 key while Windows XP Professional is starting, type 1 to choose Safe Mode from the startup options, and then press ENTER. 

Method 1: Repair or re-create the local Group Policy file 
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To repair the local Group Policy file, follow these steps: 

1.

Click Start, click Run, type cmd, and then click OK.

2.

At the command prompt, type the following command, and then press ENTER: 

esentutl /p Drive:\WinDir\security\database\secedit.sdb
Note In this command, Drive is the hard disk drive where Windows XP Professional is installed, and WinDir is the folder where Windows XP Professional is installed.

3.

Try to install IIS. If you cannot install IIS, complete the following steps to re-create the local Group Policy file. 

To re-create the local Group Policy file, follow these steps: 

1.

Click Start, click Run, type explorer, and then click OK.

2.

Locate and then open the Drive:\WinDir folder.

3.

Create a new folder in the Drive:\WinDir folder, and then name the new folder OldSecurity. To do this, follow these steps: 

a. 

Double-click the WinDir folder.

b. 

On the File menu, point to New, and then click Folder.

c. 

Type OldSecurity, and then press ENTER.

4.

Move all the files that have a .log file name extension from the Drive:\WinDir\Security folder to the Drive:\WinDir\OldSecurity folder. To do this, follow these steps: 

a. 

Double-click the Security folder, and then hold down the CTRL key while you click each file that has a .log file name extension.

b. 

On the Edit menu, click Cut.

c. 

Locate and then click the OldSecurity folder.

d. 

On the Edit menu, click Paste.

5.

Find the Secedit.sdb file in the Drive:\WinDir\Security\Database folder, and then rename the Secedit.sdb file to Secedit.old. To do this, follow these steps: 

a. 

Right-click Secedit.sdb, and then click Rename.

b. 

Type Secedit.old, and then press ENTER.

6.

Click Start, click Run, type mmc, and then click OK.

7.

Add the Security Configuration and Analysis snap-in. To do this, follow these steps. 

a. 

Click File, click Add/Remove Snap-in, click Security Configuration and Analysis in the Available Standalone Snap-ins list, and then click Add.

b. 

In the Add Standalone Snap-in dialog box, click Close.

c. 

In the Add/Remove Snap-in dialog box, click OK.

8.

Right-click Security and Configuration Analysis, and then click Open Database.

9.

Locate the Drive:\WinDir\Security\Database folder. In the File name box, type Secedit.sdb, and then click Open.

Note If you receive a message that states that access is denied, you can ignore the message.

10.

Right-click Security and Configuration Analysis, click Import Template, type setup security.inf, and then click Open. 

11.

If you are prompted to restart your computer, restart your computer.

12.

Try to install IIS. If you cannot install IIS, complete the steps in Method 2.

Method 2: Integrate the Windows XP Professional SP2 installation files into the original version of the Windows XP Professional installation files
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To integrate the Windows XP Professional SP2 installation files into the original version of the Windows XP Professional installation files, follow these steps: 

1.

Create a new folder that does not contain any files. To do this, follow these steps: 

a. 

Click Start, click Run, type cmd, and then click OK.

b. 

At the command prompt, type cd \, and then press ENTER.

c. 

At the command prompt, type md winxp, and then press ENTER.

d. 

At the command prompt, type cd winxp, and then press ENTER.

e. 

At the command prompt, type md i386, and then press ENTER.

2.

Put the original version of the Windows XP Professional CD into your CD drive.

3.

At the command prompt, type the following command, and then press ENTER: 

xcopy /E /I /V CD_Drive:\i386\*.* /s Drive:\winxp\i386
Note In this command, CD_Drive is the CD drive where the original version of the Windows XP Professional CD is located.

4.

Remove the Windows XP Professional CD from the CD drive, and then put the Windows XP Professional SP2 CD in the CD drive.

5.

At the command prompt, type the following command, and then press ENTER: 

CD_Drive:
Note In this command, CD_Drive is the CD drive where the Windows XP Professional SP2 CD is located.

6.

At the command prompt, type the following command, and then press ENTER: 

xpsp2 /integrate:Drive:\winxp
7.

Install IIS.

8.

When you are prompted to locate the Windows XP Professional installation files, type Drive:\winxp, and then press ENTER.
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Stating Indexing Service

To start the Indexing Service on a particular catalog:

· Go to Start -> Control Panel
· For Category View choose Performance and Maintenance followed by Administrative Tools
· For Classic View go directly to Administrative Tools
· Next go to Computer Management
· Open the Services and Applications then open Indexing Service.

· Right click on the catalog you want to start and choose All tasks -> Start.

Data Publishing Tutorial
This tutorial is aimed primarily at type 2 users as it takes you through the process of publishing your own files on your own local PC.  Type 3 users should also work through this tutorial.  However there are some sections that are relevant and useful for type 1 users.  These sections are: File Properties which starts on the second page of the tutorial, and Viewing through Internet Explorer, which is the last section before the summary.  We assume you have gone through the system requirements and have installed all the necessary software.  The tutorial uses some example files that are available on the distribution CD.

Copying the Sample files

· Create a new folder called samples on your C: drive and copy the contents of the samples folder from the Logbook distribution CD to this new folder.  Make sure you include all the sub-folders.

Figure 1 shows the folder structure of samples together with the contents of the top level folder.
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Figure 1: Structure of the samples folder and contents of the top-level folder
There are several sub-folders under C:\samples – this is designed to represent a typical folder structure that a researcher might have for a project.  Most of the files are Excel spreadsheets or Word documents but there are also a few other types of file including some photos.

Preparing folders for publishing

· Now create a folder called LB-Publish on your C: drive and create two sub-folders called options and publish.

The publish folder is for the published data and will contain the publish.mdb database together with the html files for viewing the published lists.

The options folder will contain the options file which is an Excel workbook used by the Logbook Assistant for harvesting the file properties.  Chapter 4 gives more information about the options file.
· Copy the two Excel files – localhost options.xls and intranet options.xls – from the folder C:\Program Files\Logbook\options to your newly created options folder.

The structure of your folders should now be as shown in figure 2 below:
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Figure 2: LB-Publish folder structure

File Properties

This section is important for type 1 users.

Most of the files in the samples folder already have properties in place.  We will have a look at some of these.

· In Windows Explorer open the folder C:\samples\Experiment Protocols
· Rest your cursor on the file NM16PROT.doc for a short while and a pop-up will appear giving you some information about the file.  The following information appears:


[image: image20]
· Now right-click on the file NM16PROT.doc and select Properties from the pull-down menu.

· Click the Summary tab.  The file properties will appear as shown in figure 3 below.
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Figure 3: Properties of the NM16PROT.doc file

Microsoft provides six properties on the Summary tab.  These are Title, Subject, Author, Category, Keywords and Comments.  The Title, Author and the contents of the Comments property were included in the pop-up box shown earlier when we rested the cursor on the file.

The Title property enables us to have a much shorter file name but still view the complete title without having to open the file.  In the Author property in this example there are five authors listed.  Note that the five names are separated by commas.  The data publishing system recognises the comma as the separator and realises that there are five separate values.  On the published lists you will be able to select by any of the authors individually.  The format we are using for an individual author is:

<surname><space><initial><full-stop>

e.g. Malingu D.  Although this format is not fixed from the data publishing point of view, it is a good idea to establish a convention within your organisation that all researchers should keep to.

Our example also has a Category value of protocols.  In the published lists the files can be selected according to the category and it is a good idea within an organisation to develop a set of categories and for all researchers to choose from that list when setting this property.  This will lead to better management of files within the organisation and avoid obscure categories being invented by individual researchers.

The Comments property is where new properties – relevant to the organisation or project – are defined and given values.  There is a very strict syntax within this property which must be followed.  In this example we have:

ecaplan: 1.2, 1.3, 2.4; Experiment: NM16; Location: Jerusa Farm

The syntax here must be:

<prop1>: <val1>, <val2>, …, <val#>; <prop2>: < val1>, <val2>, …, <val#>; …;<prop#>: < val1>, <val2>, …, <val#>

Thus properties are separated from each other with semi-colons, properties are separated from their values with a colon, and values for the same property are separated from each other by commas.

In our example we have three properties defined – ecaplan, Experiment, and Location.  ecaplan has three values (1.2, 1.3 and 2.4); Experiment has one value (NM16); and Location also has one value (Jerusa Farm).  These three properties are considered important in our example set of files and are given values for many of the files.  The sample files are from a research programme in East and Central Africa (ECA) and there is a strategic plan for the programme.  It was decided to match files to parts of the strategic plan and so the property ecaplan was created.  It was also felt to be important to know which experiment the file relates to and whether the file contents related to a particular location.  Thus the properties Experiment and Location were created.

It is a good idea for the organisation or project team as a whole to put together an agreed list of properties and possible values.  
Some of our example files do not have properties set so by way of example we are going to set some property values.  

· Open the folder C:\samples\photos and right-click on the file 6 mo old sesbania fallow.jpg
· Choose Properties from the pop-up menu, click the Summary tab and enter the property values as shown in figure 4 below:
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Figure 4: Properties of the file 6 mo old sesbania fallow.jpg
Note that the Category property is not available for JPEG files.  This is because this is an image file and the properties are stored slightly differently to the way they are stored in other files.  Thus we are declaring “Category” as a user-defined property in the Comments field.  This is explained in more detail in Chapter 1 where we talk in more detail about file properties.
· In the same way set properties for the other JPEG image files in this folder as shown in the table below:
	File name
	Title
	Author
	Comments

	Farmers fld day.jpg
	Training Day for Farmers
	Unknown
	ecaplan:1.1;category:photos

	Harvesting sesbania.jpg
	Harvesting Sesbania
	Unknown
	ecaplan:1.1;category:photos

	Leucanena pc.jpg
	Leucaena
	Unknown
	ecaplan:1.1;category:photos


Two of the JPEG files already had properties set but in each of these the syntax in the Comments property needs to be corrected.

· Open the properties for the file ahi.jpg
The entry in the Comments property is currently ecaplan=1.1;category=photos.  The equal signs are incorrect and should be changed to colons.

· Change this value to ecaplan:1.1;category:photos
· In the same way edit the properties for the file Shinyanga paper folders.jpg, again changing the equal signs (=) in the Comments property to colons (:).

We have seen that for JPEG files the Category property is not available.  For GIF files all the properties are disabled.  

· Right-click on the file Grafted mangoes.gif and select Properties.

· Go to the Summary tab.  The properties you see are shown in figure 5 below:
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Figure 5: Properties of a GIF file

These properties are to do with the image and they cannot be changed.  

· Click the button <<Simple
This takes you to the six properties that you would normally expect to be able to change but in this case all the properties are disabled.  On GIF files you cannot change any of the properties.  
For more information on File Properties and how they differ between different types of file, see Chapter 1.

Additional Meta-data

In the samples folder there are three files that contain meta-data common to many of the sample files.  These files contain titles for some of the abbreviations used in the file properties.  For example many of our sample files relate to particular experiments and in the file properties these experiments are referred to by a code – e.g. NM15.  The meta-data files contain, among other tings, the titles associated with these codes.  When these meta-data files are loaded, the Logbook publish database will always associate the codes for the experiments with the corresponding titles.  The published lists will display the titles.  This means we can view the files by title of experiment without having to include the full title in the properties for each individual file.  In Chapter 5 we look at these meta-data files in more detail to see how they affect the data publishing display.  For now we will just look at the properties of these files.

 Two of the three files are Excel workbooks and the third is an Access database.
· Look at the properties of the file Data hierarchies.xls
Note: the Category, Subject and Keywords properties for this file are disabled.  
The property we are interested in here is the Comments field where we have archive:project 1.2.  This user-defined archive property with the value of project 1.2is the trigger for Logbook to load meta-data from this file.  Project 1.2 matches one of the database properties of the publish.mdb database.  

Note: database properties are not the same as file properties – this is explained in more detail in Chapter 5.
· Now look at the file properties of the Access database file ECA Strategies & Experiments.mdb.  You should notice that there are no properties set.

· In the Comments property enter archive:project 1.2.  Click OK
What we have done so far is:

· prepared the physical location for the publish database - C:\LB-publish\publish
· copied across the options file ready for customisation – C:\LB-publish\options\localhost options.xls
· determined the set of files to be published and set appropriate file properties on these files – C:\samples
The next steps are to:

· create virtual directories under Internet Information Services so that we can view the file lists on the Web – in this example we are publishing to the local website, i.e. viewing files from the current machine, but the principle of creating virtual directories is the same whether we are preparing files to view locally or from other machines on the intranet;

· customise the options file

· load Logbook and harvest the data

· view the published data

Creating Virtual Directories

The next task then is to create virtual directories under Internet Information Services.  You may need administrator rights to do this.
· Go to Start -> Control Panel
· If you are using Category View choose Performance and Maintenance followed by Administrative Tools
· If you are using Classic View double-click on Administrative Tools
· Open Computer Management
· On the left hand side of the window go to Services and Applications and open this list.

· Click the plus sign next to Internet Information Services, then open Web Sites and Default Web Sites
· Right-click on Default Web Sites and choose New -> Virtual Directory.  Click Next.

· Enter Samples as the alias for your sample data – click Next
· Enter the full name of the folder containing the data to be published – for our tutorial this is C:\Samples.  Click Next.

· For this exercise we want to allow all permissions so tick all five boxes – Read, Runscripts, Execute, Write and Browse.  Click Yes to the warning message.  In this example we are publishing to the local machine so enabling all permissions is not a problem.  Enabling these permissions will allow us to edit the file properties from the published lists.  We will talk more about permissions later in this manual in Chapter 2.
· Click Finish.
You should now see a folder structure identical to that under C:\Samples.  You also need to create a virtual directory to link to the published data folder – i.e. the folder that will contain the publish.mdb database.  In our example this is C:\LB-publish\publish.

· Again right-click on Default Web Sites and choose New -> Virtual Directory.  Click Next.

· Enter Publish as the alias for the publish folder – click Next.

· Enter the full name of the published data folder – C:\LB-publish\publish.  Click Next
· Again allow all permissions then click Finish.

You should now have a structure similar to that shown below in figure 6:
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Figure 6: IIS Virtual Directories

Customising the Options File

The Options file is an Excel workbook that is used by Logbook to set up the publish.mdb database ready for publishing.  The Logbook toolkit comes with two example options files – one designed for publishing to the local machine, and the other for publishing on an intranet.  Both files contain nine worksheets.  Those of you familiar with using the Logbook toolkit for managing your data will have heard the term “Logbook Compliant”.  This means that a worksheet is set up in such as way that the Logbook Assistant knows where in the database to store all the information and data from the worksheet.  In the options file all the worksheets are “Logbook Compliant”.  The contents of the first two sheets are discussed in more detail in Chapter 4 of this manual.  As users you do not need to worry about the other seven worksheets and should leave these unchanged.

The first two sheets are called options and roots respectively.
· Open the file C:\LB-publish\options\localhost options.xls and go to the first sheet (options).
This sheet has five rows plus a header row.  You will change the values in column D.

· Type Sample Data into D2 – this is just a title.

· Type C:\LB-Publish\publish into D3 – this tells Logbook where to create the database file and various other files used in data publishing.

· Type /publish into D4 (Note that in Excel if you try to type a forward slash directly into a cell you will be taken to the menu bar.  Therefore you will need to move into the formula bar first before starting to type) - publish is the name of the virtual directory you created for the published folder under IIS.  When you enter this value it is relative to the default web site so you must enter it as /publish.
Note: Virtual directories use a forward slash as a separator whereas physical folders on your PC user a backward slash.
· In D5 type http://localhost – in this exercise we are publishing on the local machine so it is enough to say this is the localhost.  If we were publishing on an intranet we would have to specify the name of the PC on the network.

· In D6 type /Samples (remember to move into the formula bar first).  This is the name of the virtual directory we created to link to the physical folder containing the data to be published.  Do not confuse this with the physical location of the data on the PC.

Your sheet should now look like figure 7 below:
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Figure 7: Options sheet after customisation

· Now move into the worksheet called roots.  Currently this has 6 rows plus a header row.
· Delete rows 3 to 7 – these are not needed for our example.

· Change the value in A2 to C:\Samples – this is the physical location of the data on the PC.

· Change the value in D2 to /Samples – this is the name of the virtual directory relative to the default web site – remember that the virtual directories are separated by a forward slash whereas physical folders are separated by a backward slash.  Also remember to move into the formula bar before typing.

· Close the file saving the changes as you do so.

Load Logbook and Harvest the data

We are now ready to publish the data.

· Load the Logbook Assistant.  This should be found under Start -> All Programs -> Logbook.  Alternatively go to C:\Program Files\logbook\bin and run the application lb.exe
· Click the Output options button on the toolbar and type in the location of the options file you have just customised.  This should be c:\LB-Publish\options\localhost options.xls
Note: Logbook expects the options folder to be at the same level in the folder structure as the publish folder.  Thus we have publish and options both as sub-folders to C:\LB-Publish.

· Click OK
· Go to the menu ProactiveShare and choose the option Pro-active Share.  This may take a little while but should eventually load the data and open and Internet Explorer Window with a link to View Data from Sample Data.

· Minimise this window and click OK on Logbook.

Those of you familiar with the Logbook Assistant for managing your data will recognise the Logbook Assistant Window.  Here the screen is divided into two with the left hand side showing a tree structure and in this case the right hand side showing the files associated with each node of the tree.

· In the left hand panel double-click on Logbook (or click the plus sign).  Figure 8 shows how the left hand panel should now look.
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Figure 8: Logbook Assistant view showing left hand panel
· Double-click on View Data by Research Activity and click on NM15
Figure 9 shows the Logbook view at this stage. 
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Figure 9: Logbook view of files in the experiment NM15

There are four files listed in the right hand panel.  Each file has a path number associated with it – this is just a unique identifier generated by Logbook.  The first file in the list (number 85) has a title and the following other properties:

Category: Maize yield

Author: Jama B., Kiwia A., Oloo M.

Year: 1996

Folders: C:\Samples\Experiment data\NM15

ecaplan: 1.2, 1.3

Experiment: NM15

This collection of properties means that this particular file will appear in nine different lists.

· Double-click on View data by type in the left hand panel.

· Double-click on Data then click on Maize yield.

This time there are 25 files in the list but you should notice the same file with number 85 further down in this list.

· In the same way see if you can locate this file in each of the lists associated with the 3 authors (View data by owners).

· In one of the lists double-click on the path number (85).  This will open the file for you to view the contents.  (As the file is on your own PC you will be able to edit the file and save the changes).
Viewing through Internet Explorer

This section is important for type 1 users.
· Close Logbook then go back to the Internet Explorer Window you minimised earlier – if you closed the window rather than minimising it then go to your publish folder (C:\LB-publish\publish) in Windows Explorer and double-click on the file ViewWebSite.htm
· Click on View Data from Sample data – you should see the list shown in Figure 10.
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Figure 10: Data publishing viewed through Internet Explorer

This display is similar to the Logbook Assistant display we saw earlier in Figure 8.  The screen is split into two and on the left hand side are links to view the data in different ways.

· Click on View data by Research Activities then click on NM15
You should see the same four files in the table on the right hand side as you saw earlier from the Logbook Assistant screen.  In this table there are hyperlinks which either open the file (first column) or take you to other lists according to Author, Category or Year. The last two columns in this table will be explained in Chapter 6.
· Click on Maize yield in the first row of the table.  This immediately takes you to the list of files which have Maize yield as the value of the Category property.

In many cases there is more than one “author” for a file.  The data publishing system allows us to select individual authors.

· Try this by clicking on any author – you will see all files that include that person as a value in the Author property.

· Use the links to familiarise yourself with browsing the lists.

Summary

This tutorial covers everything you need to know about publishing to your own PC.  Further information on many of the issues can be found later in this manual.  Chapter 1, for example, goes into more detail about file properties and how to set them;  Chapter 2 looks at sharing folders so that others (e.g. the data manager) can create published lists on a central server for all staff to access; Chapter 3 details the method of creating virtual directories under IIS both for folders on your own machine and for shared folders from other machines on the network domain; Chapter 4 looks at the options file with particular emphasis on the first two sheets in the file; Chapter 5 explains how to set up Excel worksheets for loading meta-data (e.g. titles for property values) and Chapter 6 goes through the process of harvesting the data and viewing the published lists.  

A separate “Getting Started Guide” is available for those who prefer to let others harvest their data for publishing and viewing on a central server.  It covers the same contents as chapters 1 and 2 in this manual – i.e. setting file properties and sharing folders.
In the introduction to this manual we said that Data Publishing is our solution to maximising data Access.  So what is driving our data access strategy?  We can identify three levels of data access:  physical, logical and mental.

Physical data access:
Our main concern is ensuring that data are physically stored safely in a known and accessible place, and to guarantee that they are available both now and in the future.  Data that are not physically preserved have no value.  The challenge is that these data are located on different computers, or they may be on just one computer, but are mixed up with a million other irrelevant files.  How do we access these data from a single point?  Virtual Directories in Internet Information Services were designed to solve this problem.  These directories help bring together data that are physically distributed throughout the organisation.  These are described in detail in Chapter 3.

Logical access:

Data may be physically preserved but they are useless to you if you cannot access them.  Data are logically accessible if the owner of the data has given you permission to access them.  How do you control who has logical access to your data?  This is done through permissions that you set when folders and files are shared.  This is described in Chapter 2.

Mental access:
So you have both physical and logical access but still don’t understand the contents.  The data are still not valuable.  It might help if you know how the data were produced (the protocol used) or how the data were used (some publication).  It might help if you could figure out what study generated the data and consequently what the other related data are.  This we call Data Navigation.  To navigate the data we require directions (in the form of meta-data).  This is what we are capturing in the file properties.  File properties are described in detail in Chapter 1.

Data are not a global public good until they are accessible physically, logically and mentally.  Data Publishing is helping with all these aspects of data access and the chapters in this manual are explaining the technologies to do it.
Chapter 1 – File Properties

Files and folders have property sheets which display information such as size, location and the date the file or folder was created.  To view the properties of a file you should right-click the file in Windows Explorer and choose Properties from the pop-up menu.  The properties displayed depend on whether this is a file or folder, the file type and the type of file system on your drive.  Depending on the type of file or folder you will see one or more tables each with different “properties” of the file.  This chapter is important for all types of user.
General 

The General tab is always shown.  This identifies the file type, the program associated with the file, the file size and location and the date it was created, last modified and last opened.

Security

This tab lists other users who can modify, read and execute the file, view folder contents, write to the file, or have read-only access.  This tab does not appear for files or folders that are on removable media such as CDs, zip disks or memory sticks.  Nor does it appear on any hard disk drive (internal or external) that is not formatted as NTFS.

Sharing

This tab appears for folders only and allows you to share the folder with other users across the local network.

Custom

This tab appears for MS-Office files (with the exception of MS-Access database files).  This tab allows you to create new properties for files.  For each new property created you would define the name of the property, its type (e.g. text, date) and enter a value.

Summary

The properties on the Summary tab are the ones used in Data Publishing.  This tab will always be present for Excel, Word and PowerPoint files.  For these file types the properties on the summary tab are included as part of the data stream.  For most other file types (with the exception of image and audio files) including MS-Access database files, these properties are only available if your drive is formatted as NTFS (New Technology Filing System).  The alternative for most drives on a standard PC is FAT or FAT32 (File Allocation Table).  In NTFS files have multiple streams and the properties on the summary tab are stored on a separate stream to the data.

Under the Systems Requirements section there are instructions for checking whether your drive is formatted as NTFS or FAT and instructions for converting from FAT to NTFS.  Note: memory sticks tend to be formatted as FAT and CDs use CDFS (CD-ROM file system), neither of which supports multiple streams.  Copying a file from an NTFS drive to a memory stick or CD will result in the summary properties being stripped off.  This does not apply to Excel, Word and PowerPoint files where the properties are part of the data stream.

Audio and image files differ in that most use Exif (Exchangeable Image File Format).  The result is that the summary tab is available regardless of whether you have a FAT or NTFS drive.  However, depending on the file type, not all the properties on the summary tab will be enabled.  For most file types the following properties are available for editing by the user: Title, Subject, Category, Keywords, Comments.  The following table lists some of the main image and audio file formats and indicates which of these properties are enabled:

	File extension
	File Type
	Properties enabled

	.bmp
	Bitmap
	None

	.jpg
	JPEG image
	All except Category

	.tif
	Tagged Image File Format
	All except Category

	.gif
	GIF image
	None

	.wmf
	Windows meta-file
	None

	.psp
	Paint-Shop-Pro
	All

	.wma
	Windows media Audio
	Title and Comments only

	.mp3
	
	Title and Comments only

	.wav
	
	None

	.mid
	Midi sequence file
	All

	.avi
	Video clip
	None

	.wmv
	
	Title and Comments only


File properties are used by different people in different ways.  Here we are describing how the Data Publishing solution uses them for the purpose of documenting research “data” in a way that is both human friendly and machine readable.  The latter is impossible without a well defined syntax for capturing the meta-data, and that is the innovation with the data publishing solution.  We will now look in more detail at each of the six properties that can be set on most files and how they are used in Data Publishing.

Title

The title is used to give more information about the file contents than can be contained in the file name.  For example: Filename: zhfa.sps, Title: SPSS syntax to calculate height for age nutrition score.

From the Data Publishing point of view the title is free text and can effectively be any length.  Ideally though, you should try and avoid duplication in the properties of a file and therefore not include information in the title that is included in other properties.  For example imagine a file with the following properties:


Title: Proposal for Childhood Poverty Study written by Jane Taylor.


Author: Taylor J.


Category: Proposals

We don’t need the term “Proposal” or the author’s name in the title as these appear in the Category and Author properties.  Therefore, in this example, we should change the title to “Childhood Poverty Study”.

Subject

The dictionary definition of “subject” is “The person or thing being discussed”.  For Data Publishing we recommend that this field be used for associating the file with a study (i.e. experiment or survey).  Study is a very important descriptor that is unfortunately often omitted.  Equating the Subject field to the study will, hopefully help users to remember to complete these details.  This field can then be used for linking all files from a single study.
Category

The Category property can be used to describe the type of document or output (note this is not the same as the file type).  The purpose is to help trace where in the research life cycle the data was produced; e.g. during the planning, execution or reporting phase.  Descriptors such as “concept note”, “proposal”, “planning workshop”, “raw data”, “final report” etc. help to capture the different phases.  If you are tracing the research progress, these are the terminologies that would be useful.  Within an organisation or project it should be possible to devise a comprehensive set of relevant categories and sub-categories.  If the list of possible categories is determined beforehand, this helps the average user as they only have to fit their files into existing categories rather than invent their own categories.  This also leads to better synchronisation within the organisation as users will be keeping to the same terminology in describing their files.  The following table gives examples of categories and sub-categories and can be adapted to suit any organisation or project.

	Category
	Sub-category

	Reports
	Project reports

Conference reports

Minutes of meetings

Workshop reports

	Papers
	Conference papers

Framework papers

	Proposals
	CVs

	Protocols
	

	Policy documents
	

	Contracts
	Contracts with donors

Contracts with staff

	Reviews
	Software reviews

Project reviews

Book reviews

	Raw or derived data
	Maize yield

Tree growth

Treatments

PAR measurements

Child Height

Child Weight



Of course a file may fit into two or more categories and later in this manual we will show how to specify several categories and sub-categories for a single file.

Keywords

Keywords would be words or phrases that are of interest to the organisation or project.  As with categories, it is probably best if these are pre-defined by the organisation as a whole which will again lead to better synchronisation of files and more consistent ways of describing files.  This field is not useful for electronic resources that can be searched using a full text index, such as Word documents.  It is, however, useful for non searchable files such as pictures, maps and Excel files to help capture words that are key to the description of a resource.  Such words should not appear in any other file property.
Author

The “Author” category can be used not only to list individuals who have contributed towards writing the file, but also to the “owner” of the file.  This field typically contains the list of people that could be contacted for further information about the data.
Comments – User-defined properties

The Comments property is used in Data Publishing for declaring and assigning values to user-defined properties.  As with the values for properties such as Category, it is a good idea to have the user-defined properties and possible values determined by the organisation as a whole.

The properties you choose as an organisation determine the selection criteria or nodes on the left-hand side of the Data Publishing window.  For example you may want to be able to select files by location, by experiment or by year and so would have location, experiment and year as user-defined properties.  You may have a long-term planning document within your organisation and may want to record which sections of the plan your files refer to.  For this you could have a property called something like orgplan with values referring to the sections of the plan.  For example, in the Data Publishing Tutorial, the sample files are to do with the “East and Central Africa Regional Program” and there is a user-defined property used called ecaplan.  The values of this property refer to sections and sub-sections of the strategic plan.  

Note: Traditionally the CUSTOM tab is used for designing user-defined properties.  However, in the development of the Data Publishing system this was avoided because it is not available for some file types and it is also somewhat hidden.  Instead the Comment field is structured to provide this functionality.
Syntax for Properties

For data publishing there is a very strict syntax for defining property values.  The Title is generally free text and can be any length.  For Subject, Category, Author and Keywords you can define several values which must be comma separated – e.g. 

Keywords childhood, poverty, nutrition
For authors you should have a format for the author’s name that is consistent throughout the organisation.  You might decide to use full names as in “Cathy Garlick” or surname and initials as in “Garlick C.A.”  Consistency is important here as you ideally want to avoid listing some files under “Cathy Garlick”, others under “Garlick C.A.” and perhaps some under “Garlick C.”  From the data publishing point of view these are 3 separate individuals.

Values for properties can be nested and a forward slash is used to separate the levels.  For example let’s assume you have a category called reports and a sub-category conferences.  You could define these levels by entering the Category value as 

reports/conferences
In the Comments the syntax is very specific as you are defining new properties as well as setting values.  You can define several properties for the file.  The first item in Comments is assumed to be the name of a property.  This is separated from its values with a colon (:).  Thus you could have:

Experiment:NM1
which would define a property called Experiment and give this the value of NM1.  To define another property use a semi-colon to separate one property and its values from the next property.  Thus:

Experiment:NM1; Year:2005

defines two properties, Experiment and Year giving them the values of NM1 and 2005 respectively.  Remember that a property can have multiple values and can have nested values.  Thus:

Experiment:NM1, NM2/Section 3; Year:2005

would define the file as being connected to experiment NM1 and Section 3 within experiment NM2.

There is an option of defining a “title” for property values which would give further information.  Do not confuse this with the Title property.  This is done by following the property value with an equals sign.  The text following the equals will be treated as a title for that value.  For example:

Experiment:NM1=”Effect of Sesbania, Maize and weeds on Nutrient Dynamics, Movement and Capture”

The double-quotes are generally optional but are needed in this example because the title itself includes commas.  When these data are published, the title will appear with the value on the left-hand side of the screen.

Assuming properties and their possible values are known in advance, there is a method of loading and storing these together with any titles associated with the values, in a separate file which can be loaded separately into the data publishing database thus removing the need to give full details for every file.  This method is covered in Chapter 5.
Chapter 2 – Sharing Folders and Drives

If you only want to publish lists of your own files on your own PC then you would not need to worry about sharing your files.  However, the chances are you are part of an organisation and want to be able to have your files published on a local intranet.  You may either be viewing the published lists from your own Pc or, more likely, be viewing lists published on a local server.  Either way you will need to have some understanding of sharing your folders and setting permissions for others.  This chapter is important for all types of user.
Requirements for Sharing

· You must be part of a domain.  When you connect to the network you may be part of a workgroup or part of a domain.  If you want to publish your files to an intranet you will need to be on a domain.  In the System Requirements section there are instructions for you to find out whether you are part of a workgroup or part of a domain.  See your IT support staff if you need to move to a domain.

· You must be running Windows Professional and not the Home version of the operating system.  The Home version is not designed for sharing across networks.  To check which operating system you are using go to System under Control Panel (sub-section Performance and Maintenance if you are using Category view)

· You must be at least a Power User.  To find out what type of user you are on your PC go to Administrative Tools -> Computer Management under Control Panel (sub-section Performance and Maintenance).  Double-click on Local Users and Groups on the left hand side then click on Users.  Right-click on your own username in the list on the right hand side and choose Properties.  Click the Member of tab.  This will tell you which local groups you are a member of.  If you are a member of Users group only then you will need to find someone with administrator rights to add you to the Power Users group.

Sharing Folders

If you want other users to have access to your files across the network you will need to share the folders containing the files.  You do not share individual files but instead share the folders containing the files.  When you share a folder, others will have access to the contents of that folder including all the sub-folders.  To share folders when on a domain there are several methods.  The easiest is to use Windows Explorer:

· Open Windows Explorer

· Locate the folder or drive that you wish to share.  Note: you cannot share individual files but must share the whole folder.

· Right-click the folder and choose Sharing and Security from the pop-up menu.

· Click Share this folder.  Figure 1 shows an example.
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Figure 1: Sharing a folder with the share name of “samples” 
Note: By default the Share name is the same as the folder name but you can change this.  The Share name is the name that others will use to connect to this folder.  There is space for you to type a comment about the shared folder if needed but this is optional.  If used, the comment will appear in the Comments column when others are viewing the folders across the network using the Detail view.
Setting Permissions

Before clicking OK you can set permissions for different users.

· Click Permissions.  The following dialog box appears.
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Figure 2: Permissions for samples
The default share permissions is for everyone to have read access.  This means that anyone on the same domain can read your shared folder and all files and sub-folders within it but they cannot make changes.  If you are not happy with everyone being able to read your files then you will need to remove everyone and add individual users or groups.  To remove everyone:

· Select everyone in the Group or User names list and click on Remove.

A group is a collection of computers or users generally used for security of e-mail distribution.  For example a group may consist of all users working on a particular project.  Permissions can be granted to the group as a whole rather than having to specify individual users.  If you need to create a group or be added to an existing group then you should contact your IT support staff as groups are created centrally on domains.

To add users and/or groups to the list click Add.  The following dialog box appears:
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Figure 3: Select users to access the shared folder
This is where you select the users, computers or groups that you wish to give access to.  Generally it is easier to give permissions to groups – your IT support staff should be able to tell you which groups are available on the domain and which users are members of these groups.  Alternatively you would need to know usernames or computer names.  A list of computers and users should be available within your organisation.

Assuming that you know the object names (users, groups, and computers) for which you want to set permissions, enter these names into the box provided.  Multiple names can be given if separated by semi-colons (;).

· Click Check Names – this will check that the names you have entered are valid on this domain.  If an object cannot be found (perhaps because you have spelt it wrong) then you will receive a message to that effect.

· Click OK when you have finished your list.

At this point you may be asked for the username and password of an account with permissions for the domain.  Enter your own username and password but prefix your username with the name of the domain.  This should be in the form 

Domain\username
e.g.


rdg-home\snsgrlic
Each object (group or user) will be granted read permission by default but you can change this to allow more permissions to some users.

Permissions on Shared Folders

There are 3 levels of permissions on shared folders – read, change and full control.

Read permission allows:

· Viewing file names and sub-folder names

· Moving to sub-folders

· Viewing data in files

· Running program files

Change permission allows all read permissions plus:

· Adding files and sub-folders

· Changing data in files

· Deleting sub-folders and folders

Full control permission allows all change permissions plus:

· Changing permissions

· Taking ownership

It is wise not to allow Full Control on your shared folders!  If you have any problems with file permissions please contact your local IT support team.
Security
Users to whom you have given permission should now be able to see your shared folder across the intranet and will be able to mount your shared folder as a drive on their own PC.  However, they will not have access to the files within the folders unless they, either as individuals or as members of a group, are given security access.

· Right-click the folder you are sharing and again choose Sharing and security from the pop-up menu.

· This time go to the Security tab.  Figure 4 shows what you might typical see from this tab.
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Figure 4: Security Permissions

In this particular example, SNPC239 is the name of the local machine and snsgrlic is the owner of the file.  She is the only person with permissions on this folder.  The share permissions for this same folder are shown in Figure 2 shown earlier.  This indicates that the folder is shared to everyone.  However, because of the security permissions, users on other machines will be able to see that the folder has been shared but will not be able to see the contents unless they provide the correct username and password.  In this example they would need to specify snpc239\snsgrlic as the username and give the corresponding password.  They will be asked for the username and password the first time they try to open the shared folder.

To add individuals to the security list, click Add then enter the usernames or group names in exactly the same way as you add users and groups to the share permissions (see figure 3).  Adding Authenticated Users to the list means that everyone on the shared permissions lists, who is able to supply a valid username and password for the domain, will be able to access the shared files.

Security Permissions

We saw earlier that there are three levels of permissions on shared folders: - read, change and full control.  There are also security permissions as follows:

Full control:
Groups or users granted full control on a folder can delete any files in that folder regardless of the permissions protecting the file.  Users will full control can modify the permissions and even take ownership.  It is wise not to grant full control.  If Full Control is chosen – all other permissions will automatically be ticked.
Modify:
Users with Modify permission can make changes to file contents and can delete files.  When Modify is chosen all other permissions apart from Full Control will automatically be ticked.
Read & Execute: This level of permission allows users to read files, run executable files and browse through the folders.  When this permission is chosen the List Folder Contents and the Read permissions will automatically be ticked.

List Folder Contents: This permission allows users to browse through the contents of the folders but not to read any of the files.

Read:
This allows users to read the files but not to execute any programs or to navigate through the sub-folders.

Write:
This allows users to create files and folders and to edit files but not to delete files.

Note: When accessing files from a shared folder the most restrictive permissions will apply.  For example if you have granted someone modify permission under the security tab but only Read permission under the sharing tab, then they will only be able to read the files from the shared folder and not modify them.

Getting your files published

Once you have shared your files and set appropriate permissions they will be ready for publishing onto your local intranet.  We envisage that they will be published onto a local server which is accessible to other researchers within your organisation and/or project.  It is assumed that your data manager or IT support staff will carry out the harvesting of files and the publishing, and, for them to be able to do this, you will need to tell them the name of your local machine and the share names of any folders containing data for publishing.  It may also be useful if you can tell them what share and security permissions you have set on your folders – this will help them sort out any problems they may have with accessing the folders.  

By now you should know the local name of your PC.  As a reminder to find the name:
· Go to Control Panel -> Network Connections (with the intermediate step of Network and Internet Connections if you are using Category view).

· Choose Network Identification from the Advanced menu.  A dialog box similar to that shown in Figure 5 appears.
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Figure 5: Network Identification showing Full computer name and Domain

In this example the local name of the PC is snpc239.  Figure 1 shows the Share name of a shared folder – remember this is not necessarily the same as the name of the folder on your own PC.  
With this information the Data manager will be able to create links to your shared folders and will be able to harvest the file properties adding them to the published lists on the server.  He/she will then let you know the URL to use to view the published lists.  This will generally consist of 3 parts:

1. The local name of the server – remember that all machines on the domain, including those used as servers, have a unique name.  In figure 5 we said the local name of the PC is snpc239.

2. The share name of the published folder from the server – the folder on the server that contains the publish.mdb database will be shared and this is the name given to the share.
3. The name of html file to open – this is generally ViewWebSite.htm
Figure 6 shows an example where snpc239 is the name of the server and publish is the share name of the folder containing the publish.mdb database.  Note this must be entered as 


\\snpc239\publish\ViewWebSite.htm
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Figure 6 URL for published data

To view the data you simply click on the link.  This takes you to the table of published data which you can move around using the hyperlinks.  An example is shown below in Figure 7
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Figure 7 Viewing published lists from server
Chapter 3 – Internet Information Services
This chapter is important for users of type 2 and type 3.
Introduction

Internet Information Services (IIS) is the Windows XP Web Service that is used for publishing information on your intranet.

If you are a type 1 user and do not wish to publish files onto your own PC, then you do not need to use IIS.  Other users will need to install IIS – if you haven’t already done so then follow the instructions for installation under the section System Preparation and Software Installation.  Unless you have administrator rights on your PC you will need to ask your IT support staff for help with this.

Internet Information Services can be used to create your own web site or ftp site on your own PC.  If you want to find out more about IIS and creating your own web site then have a look at the online documentation which will be available by typing:


//localhost/iishelp

into Internet Explorer once you have installed IIS.

Virtual Directories

With data publishing you are effectively creating a web site through which you can browse lists of files.  Each website must have a home directory.  By default this is set to C:\inetpub\wwwroot.  All files in the home directory and its sub-directories are visible to visitors to your site.

The files you want to publish using the data publishing tool will generally not be contained within your home directory – they might even be on other machines (e.g. the data manager publishing files from the entire organisation onto a server).  In these cases you create a Virtual Directory.

A Virtual Directory is a directory that is not physically contained within the home directory but appears to client browsers as though it were.  In data publishing virtual directories are used to link to the folders containing files for publishing.  In the rest of this chapter we go through the process of creating virtual directories both for folders on the local machine and for shared folders from other machines.

Creating Virtual Directories

In the tutorial earlier in this manual we went through the process of creating a virtual directory to link to the folder containing the publish.mdb database, and a virtual directory to link to the folder containing the files to be published.  Both these folders were on the local drive.  The instructions are repeated here.

To open the Internet Information Services Management Screen there are several methods:

Method 1
1. Go to Start -> Control Panel
2. If using Category view choose Performance and Maintenance followed by Administrative Tools – if using Classic view go straight to Administrative Tools
3. Open Computer Management
4. On the left hand side of the window go to Services and Applications and open this list.

5. Click the plus sign next to Internet Information Services, then open Web Sites and Default Web Site
Method 2
· Follow steps 1 and 2 from Method 1 then open Internet Information Services.

· Double-click on the local computer name, then on Web sites and Default Web site
Method 3
· Right-click on My Computer and choose Manage
· Continue from step 4 in Method 1

Once IIS is open do the following to create the virtual directory:-

· Right-click on Default Web Site and choose New -> Virtual Directory.  Click Next
You are now asked to give an alias for your virtual directory.  Each virtual directory has an alias.  This is the name that users will use through their browsers to access the folder.  An alias is usually shorter than the path name of the folder and so is more convenient for users to type.  An alias is more secure in that users do not know where the files are physically located on your machine.  Aliases make it easier to move folders on your PC or server; instead of creating another virtual directory you simply change the mapping between the alias and the physical location of the folders.

· Enter an appropriate alias for your virtual directory.

The alias should not be too long, should be easy to remember and related to the folder contents in some way.  Use the same naming conventions that you would use for naming a folder on your PC.  For example, suppose you were working on a project called “Young Lives” and you wanted to create a virtual directory to map your project folder.  A possible alias for the virtual directory would be Young Lives.

· After entering the name of the alias, click Next
The next step is to give the physical path of the folder that contains the files you want to publish.  Remember a single virtual directory maps to a single physical folder which must be shared if you want other on the intranet to have access to it – see Chapter 2 for more details on sharing folders and setting permissions.  You can use the Browse button to locate the folder.  Bear in mind that My Documents is effectively a link to 
C:\Documents and Settings\<user>\My Documents
Therefore if you are mapping your virtual directory to a sub-folder of My Documents you must give the full pathname as:

C:\Documents and Settings\<user>\My Documents\<folder-name>

For example to link to my Young Lives folder which is a sub-folder of My Documents, I would need to specify the full path as:

C:\Documents and Settings\Cathy Garlick\My Documents\Young Lives
If you are unsure of the folder structure on your PC then ask your IT support staff for help.
Setting Access Permissions

The next step is to create access permissions for the virtual directory.  The available permissions are:

Read:
This enables other users to read or download files stored in the physical folder mapped to this virtual directory.  By default, the Read permission check box is ticked.

Run Scripts (such as ASP):  ASP are Microsoft Active Server Pages that are used to create dynamic and interactive web pages.  Data publishing uses ASP scripts to produce the published lists.  Setting this permission allows such scripts to run and this permission is set by default.  In general your shared folders for publishing will not contain ASP scripts, but there is no harm in leaving this permission set.

Execute (such as ISAPI applications or CGI):  Internet Server Application Program Interface (ISAPI) is an application program interface residing on a server for initiating software services tuned for MS-Windows.  It is an application programming interface for developing extensions to IIS.  Common Gateway Interface (CGI) is an interface for initiating software services.  A typical data publishing user does not need to understand ISAPI or CGI but anyone interested can look for further information in the online help for IIS.


Setting this permission enables the user to run any application found in the physical folder.  This includes all .exe files.  The general rule in the IIS online help is “do not give content folders execute permission”.  However, for data publishing, permissions for individual users and groups will have been set when the folders were shared, so in our case it is okay to set this permission which is not set by default.

Write:
This permission enables users to change file content and properties.  In general you might feel that you don’t want to set this permission.  However, for data publishing there will already by share and security permissions set on the folders.  If you set write permission here, but a particular user does not have write permission on the shared folder, then they will not be able to make changes to your files or their properties when viewing the published lists.  However, setting this property means that you will be able to change the properties or contents of files through the lists.

Browse:  This permission allows users to brows the virtual directory and the sub-folders.

For data publishing we recommend you set all 5 permissions.  When you click Next you will get a warning saying:

Selecting both Write and Execute permissions could be dangerous.  Are you sure you want to select both these permissions?

As we have noted, in data publishing the permissions can be controlled through the share and security permissions so in our case this is okay so click Yes.  

Note: If you are using IIS to create your own website then you will need to think more carefully about access permissions.  This is not a topic for this manual.

Your virtual directory will now be created and will appear in the list of virtual directories as shown in Figure 1 below:
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Figure 1 Virtual Directories
The IIS window is divided vertically: on the left hand side you will see the virtual directories as shown in Figure 1 above; on the right hand side you will see the contents from the physical location of the virtual directory.  You are able to browse these contents in the same way that you would browse the physical folders and their contents in Windows Explorer.

Properties of the Virtual Directory

In Microsoft almost everything has a set of properties associated with it and a virtual directory is no exception.  The vast majority of the properties you will not need to even think about – they are really for those who are designing their own websites.  However, we will have a look at the properties relevant to data publishing.

To view the properties of a virtual directory:

· Right-click on the virtual directory in the list on the left hand side and choose Properties from the pop-up menu.

A dialog box similar to that shown in Figure 2 will appear:
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Figure 2 Properties of a Virtual Directory
This example shows the properties of a virtual directory called Young Lives.  There are six tabs on this dialog box: Virtual Directory, Documents, Directory Security, ASP.NET, Custom Errors and HTTP Headers.
The Virtual Directory tab contains information about the source of the content for this directory.  In our example the content comes from “A directory (folder) on this computer”.  Later in this chapter we will show you how to link to a share location on another computer.  The Local Path shows the full pathname of the source folder.  If you change the physical location of the folder on your PC you will need to update the link to the virtual directory by changing the Local Path.  For example in Figure 2 above the Local Path is

C:\Documents and Settings\Cathy Garlick\My Documents\Young Lives
(Note: because of the length of the pathname you can only see the first half in the dialog box).  If we moved the contents of this folder to C:\Young Lives we would need to change the value in Local Path accordingly.  From the point of view of other users, nothing will have changed.
The other point of interest on this tab is the Starting Point.  This tells us that we can access this virtual directory by typing

\\hostname\Young Lives

(where hostname is the name by which the local machine is known on the intranet) into their web browser.

Directory Security

The only other tab you need to be aware of in this dialog box is Directory Security.  The contents of this tab are shown in Figure 3
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Figure 3 Directory Security

You will probably find that only the first part of the box, Anonymous access and authentication control, is enabled.  The other two sections are for use with machines running Windows Server and for those with digitally signed certificates respectively.

Anonymous access and authentication control allows you to decide whether you are going to allow any users to view your files through the web, or whether you are going to restrict access to those with valid usernames and passwords on the domain.

· Click Edit to display the dialog box in Figure 4 below:
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Figure 4 Authentication Methods

Anonymous access gives users access to your virtual directory without prompting them for a username or password.  This is similar to the person logging in as guest.  Depending on the share and security permissions you have set, anonymous access may either leave your files too open (if you have shared to everyone for example) or may deny access to those who should have access (i.e. the system is unable to recognise them as users with permissions to access your files).
Basic authentication prompts for a username and password.  This adds an extra level of security for your files.  However, passwords are not secure when they are sent over the network and for this reason this method of authentication is not recommended.

Digest authentication is an improvement on Basic authentication in that passwords are encrypted before being sent over the network.  However, digest authentication only works with Active Directory domain accounts and is not relevant to us.  If you try selecting this option you will receive a message to this effect.

Integrated Windows authentication is a secure form of authentication as the username and password are hashed before being sent across the network.  If the user cannot be identified from the current Windows user information, then they will be prompted for username and password.  Integrated Windows authentication is best suited for an intranet environment where all machines are on the same domain.  It is therefore ideal for data publishing where we are either publishing to the local machine or to an intranet.

For our purposes then, you should switch off anonymous access and choose Integrated Windows authentication on your virtual directories.

Note: Integrated Windows authentication will be ignored if Anonymous access is selected.

Virtual Directory for the Publish Folder

So far we have talked about creating a virtual directory to link to the physical location of the folder containing the data to be published.  In order to view your published results via Internet Explorer, you will also need to create a virtual directory to link to the physical location for the published results – i.e. the folder that contains the publish.mdb database.  It may be the case that your publish folder and the data folder have the same parent.  An example is shown in Figure 5:
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Figure 5: Publish and data folders with the same parent

In this example the data to be published are in the folder D:\projects\ECA system\data and the publish folder has the full-pathname of D:\projects\ECA system\publish.  For this example you need only create a single virtual directory linking to D:\projects\ECA system and both the data and the publish database are accessible through this link.  In Chapter 4 we discuss the options file which is used to tell Logbook which virtual directories to use and which data to load.

It is likely though, that your data folder and your publish folder are in different locations on your drive and in that case you will need to create a virtual directory for the publish folder.  This is done in exactly the same way that you create a virtual directory for the data folder:

· Open Internet Information Services

· Open Web Sites and right-click on Default Web Sites
· Choose New followed by Virtual Directory
· Click Next and give an alias for the publish folder – e.g. publish
· Enter the full pathname of the physical location of the publish folder.

· Set access permissions.

Linking to a Shared Folder on another PC

Provided share and security permissions have been set correctly it is possible to create a virtual directory to link to shared folders on another machine on the same network domain.  If you are viewing your published files on a shared server, the data manager or IT support team will need to have created a virtual directory on the server to link to your shared folders across the Intranet.
To create a virtual directory to link to a shared folder from another machine you will need to know:

· The name of the PC on the Intranet;

· The share name of the shared folder.

The virtual directory is then created in the same way as before:

· Open IIS; open Web sites and right-click on Default Web Sites.

· Choose New -> Virtual Directory.  Click Next
· Give an alias for the virtual directory and click Next.

· As the directory enter \\computer name\Share name.  For example Figure 6 shows the directory specification for a shared folder on the machine known on the network as snpc194 with the share name of samples.
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Figure 6: Shared folder from PC on the Intranet
Note: the properties state that the content comes from “A share located on another computer” and the Network Directory rather than Local Path is shown in the dialog box.
· Depending on the permissions that have been set on the shared folder you may then be asked for username and password.  Note: This should be your username and password on the domain which may not be the same as the username you use to log on to your own PC.

· After typing your username and password you will be asked to confirm your password so retype it to confirm.

· Set access permissions in the usual way.

Figure 7 shows the properties of a virtual directory called samples194 which is linked to a shared folder on machine snpc194 which has the share name of samples.
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Figure 7: Properties of virtual directory linking to shared folder on another machine

Note: In order to create and use a virtual directory linking to a shared folder on another machine, that machine must be switched on.  Figure 8 shows the results of trying to create a virtual directory when the source machine is not switched on and therefore not found on the Intranet.

[image: image43.png]1 5OL Server Configuration Manager
= BB tndeng servce

i % Data Managemert: samples254 Properties
« (1 web
= & Internet Information Services HITP Headers Custom Enors ASPNET
= geh S\:es‘ N Vitual Directory Documents. Directory Secuty
= ) Defaul Web Ste
2 novep ‘When connecting o ths resaurce, the conlent shouid come from
= g Piters O & dvestony located on tis comper
(g i bin @ & share located on ancther computer
(g serts O A rediectonto a URL
samples2st

¥ foe Network Diecay: [‘erpeZ5iicanpls
g taweb
. ] Serpt source ascess
1 8 publsh fead
5 8 sample vt
o e Diectoy browsing
@ privete ‘Applcaton Setings
5 0 hiLerk
& i log Appiication name: samples254
w0 _vtipvt Statting point <Defaul... \samples254
1 0 ot_sert
o0 e Execute Pemissions: | Scipts and Executables v

Hp-D19s5C
% 1 FrP Stes
]38 Default SMTP Virtual Server

Application Pratection: | Medium [Pocled) v





Figure 8: When the source machine is not found
This example shows that we are trying to connect to a shared folder with the share name of samples on the machine with the name snpc254.  Note the error in the list of virtual directories.  The same error will occur if you give the wrong share name.  To correct the share name you can change the Network Directory entry in the Properties.  Click Connect As on the properties will allow you to specify a different username and password to access the share.
If you get an error while trying to create a virtual directory check the following:-

· Is the source machine switched on?  Note: it just needs to be switched on; a user does not need to be logged in.

· Have you correctly specified the share name?  Check with the owner of the source machine.

· Have you given the correct username and password?  Check permissions with the owner of the shared folder.

Deleting a virtual directory

You will probably find that from time to time you have to delete virtual directories.  This may be because you have created it incorrectly or it may be because the source folder no longer exists.  To delete a virtual directory:

· Right-click on the virtual directory in IIS and choose Delete from the pop-up menu.  Click Yes to confirm the deletion.

Nested Virtual Directories

If you find you are creating lots of virtual directories it may be easier from the data publishing point of view to nest them.  This makes it easier when specifying the starting point for searching.  See Chapter 4 about the options file for details on this.  To create nested virtual directories first create a single top level directory.  Link this to an empty folder on your machine.  This folder must be shared if you want to be able to access it from another PC and appropriate share and security permissions must be set.

We specify an empty folder so that others accessing your machine across the Intranet do not find any of your files here.  Do not make the mistake of linking this top level directory to C:\ otherwise other users could access your entire hard drive.  We suggest creating an empty folder called, for example, C:\Data publishing – for ease of use give the virtual directory the alias Data Publishing.  Then create other directories as sub-directories by right-clicking on your top level directory rather than on Default Web Sites.

Thus the method is:

· Create an empty folder on your PC – e.g. C:\Data Publishing
· Share the folder giving appropriate share and security permissions (see Chapter 2);

· Create a top-level virtual directory (i.e. directly below Default Web Sites) to link to your empty folder – give it a suitable name, e.g. Data Publishing;

· Right-click on the top level virtual directory (Data Publishing) to create a nested virtual directory.

· In the options file set the value for Scope to \Data Publishing – See Chapter 4 for details.

Figure 9 shows nested virtual directories.  The top level directory is called Data Publishing and there are five sub-directories: publish, projects, Young Lives, samples, samples194
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Figure 9: Nested Virtual Directories
Chapter 4 – The options file

Introduction

This chapter describes the contents of the options file that is used by the Logbook Assistant when “harvesting” files to be published.  Type 1 users, who are simply sharing their files for the data manager or IT support team to publish on a shared server, do not need to use the options file.  Type 2 users will need to know how to customise the file for publishing to their local machine, and type 3 users will need to know about publishing to an Intranet.  

In simple terms the options file tells the Logbook Assistant where to find the files for publishing and where to publish them.  There are two example options files provided with the Logbook toolkit (data publishing).  The first is an example file for publishing to the local machine.  The second is for publishing to an Intranet.

When Logbook is installed, these two files will be found in the options sub-folder of the installation folder – e.g. C:\Program Files\Logbook\options
It is recommended that you make these files read-only and take copies for customisation as and when needed.

Sheets in the options file
The options file is an Excel workbook with nine worksheets in total.  The sheets are called: options, roots, HarvestFiles, HarvestProperties, FolderPathAttributes, PathHierarchy, describe 5 path-domain-attr, describe 6 domain-attr, and TagAggregate.

The first two sheets are the ones we need to customise.  The remaining seven sheets should not be changed in any way.  The details of these seven sheets will be described in the Data Managers’ Guide.  For this manual we will look at customising the first two sheets.

Options sheet

We will start by looking at the localhost options.xls file.

· Open the file localhost options.xls
· Go to the first sheet which is called options.

The contents of this sheet are shown below in Figure 1 
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Figure 1 Contents of the options sheet for localhost options.xls
The sheet has 4 columns and 5 rows plus a header row.  The columns are:
option_order:
This determines the order in which this information is loaded into the database.  Do no alter anything in this column.

option_name:
This column gives the names of the options to which you need to assign values.  You should not alter anything in this column.
option_description:
This column gives more information about the options and is designed as a prompt y to the user to help them determine the values to use.

option_value:
These are the values assigned to options and this is the column you will need to customise.

Let’s look at the five options and how the values we assign affect the data that is published.

Title:
The first option is called Title.  The value assigned to this option will affect the text of the hyperlink that we see when we open the file ViewWebSite.htm.  To produce the hyperlink shown in Figure 2 the value for the title in the option file would be “Sample files accessible from the Intranet”. 
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Figure 2: Hyperlink from ViewWebSite.htm

Publish:
The next option is publish.  The value must be the full path name of the physical folder where you want to store the publish.mdb database and other files for data publishing including ViewWebSite.htm.
Note: 
The last part of the pathname must be publish as the data publishing system expects the folder containing the published results (i.e. the database) to be called publish.  It also expects the options file to be stored in a folder called options which is at the same level in the folder structure of the PC as the publish folder.  In other words you should have folders as shown below in Figure 3

[image: image47]
Figure 3 Structure of the options and publish folders
In our example in Figure 1 the folder for publishing the results is D:\Projects\ECA System\publish.  The folder containing the options file would need to be D:\Projects\ECA System\options.

vpublish:
This next option is the virtual directory for the publish folder.  In Chapter 3 we talked about creating virtual directories under Internet Information Services (IIS).  The value for this option should be the virtual directory that links to the physical folder given as the value for the publish option.  In our example this is /projects/eca system/publish.
Note:
This is the directory relative to the website.  Thus forward slashes are used to separate the directory levels rather than the backward slashes used when specifying a physical path name.


Also note that for this example we would need to create a virtual directory to link to the folder D:\Projects – we would not need to create nested virtual directories.

Note:
If you try to type a forward slash directly into a cell in Excel, you will be taken to the menus.  Click in the formula bar first and enter the value in there.

Website:
This option tells us how to access the website.  If you are publishing for viewing on the local machine only, then you can use the generic address of http://localhost as shown in figure 1

Alternatively if you are publishing for viewing across the local intranet (i.e. you want to be able to view the published lists from other PCs on the domain), then you will need to know the name of your computer.  For example, if your computer was called snpc239 then you would enter http://snpc239 as the value for this option.  For this first sheet in the options file, the only difference between localhost options.xls and intranet options.xls is in the value for the website option – values for title, publish, vpublish and scope can be the same regardless of whether you are publishing to the local machine or to the Intranet.

Note:
Remember that to find out the name by which your computer is known on the network do the following:

· Go to Start -> Control Panel
· If using Category view choose Performance and Maintenance
· Choose System and click the tab for Computer Name.  This will tell you the full computer name which includes the domain.  The first part of this is your computer name.  Figure 4 shows an example for the computer snp239 on the domain rdg-home.
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Figure 4 Computer name and domain for snpc239.
Scope:
The final option is scope.  This identifies the start point for any search of the published data.  It is generally the name of the virtual directory that links to the physical folder containing the actual files to be published. 

In the example in Figure 1 the physical folder containing the data is D:\Projects\ECA System\data; a virtual directory – projects – has been created to link to D:\Projects and through this the sub-folder ECA System\data is accessible.
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Figure 5a: Data available for scoping
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Figure 5b: ECA system physical folder

Figure 5a shows the virtual directory projects and figure 5b shows the physical location of the projects folder on the hard drive.  In this example we can see that the folder containing the data to be published and the folder containing the publish.mdb database have the same parent folder.  This does not have to be the case.

In Figure 6 below the physical folder where the data are to be published is C:\Documents and Settings\Cathy Garlick\My Documents\Logbook3\LB-publish\publish.
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Figure 6 Second example of contents of the options worksheet

A virtual directory called publish has been created to link to this folder.  This is shown in Figure 7
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Figure 7 Properties of the publish virtual directory

The data to be published however are stored in the physical folder C:\samples.  A virtual directory called sample links to this folder and thus /sample is set as the value for the scope option.  The sample virtual directory and its properties are shown below in figure 8
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Figure 8 Properties of the sample virtual directory

Reminder: The only requirement as far as the physical location of folders is concerned is that the publish folder (which must be called publish) and the folder containing the options file (which must be called options) must have the same parent folder.

Roots worksheet
The roots worksheet is where you list the folders containing the data to be published.  This may be a single folder or a list of folders.  For each folder in the list it is assumed that all sub-folders will be included unless they are specifically excluded.
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Figure 9: roots worksheet contents from example file

Figure 9 shows the contents of the roots worksheet in the localhost options.xls files that is supplied with the Logbook toolkit.  There are four columns headed root, root_order, root_valid and webpath.

Root:
This contains the full-path names of the physical folders containing data for publishing.

Root_order:
This is simply the order in which the data will be loaded.

Root_valid:
This is either yes or no; yes indicates that data from the folder will be published and no indicates folders that will be excluded.  In are example we are publishing everything from the folder D:\Logbook\data and everything from the folder D:\Projects\ECA System with the exception of the sub-folders database, options, publish and work.  Setting this column to No is the method used for excluding sub-folders from being published when the parent is being published.

Webpath:
This indicates the path you would use to access this data from the website for the local computer.  In other words there will be a virtual directory called logbook linking to d:\Logbook and a virtual directory called projects linking to D:\Projects.

Roots for publishing to an Intranet

If you are publishing your files so that they can be viewed across the Intranet, you will need to share the folder containing the data (see Chapter 2) and you will need to include the computer name and the share name when you specify the roots.  Figure 10 shows the contents of the roots worksheet for the Intranet options.xls file supplied with the Logbook toolkit.

[image: image55.png]intranet options xis [Read-Only]

1
2 [junceanDriveD\Loghook\data 1 yes Nogbookidata

3 [tjuncean\DriveD\Projects\ECA System 2yes Jprojects/eca system
4_[tjuncean\DriveDiprojects\ECA Systerridatabase no

5 [tjuncean\DriveDiprojects\ECA Systerrioptions no

6 [tjuncean\DriveDiprojects\ECA Systerripublish no
7_[tjunceanDriveDprojects\ECA Systermiwork no

B





Figure 10 Roots for publishing on an Intranet

The computer name in this example is juncean and the D: drive has the share name of DriveD.  Thus the folder D:\Logbook\data on machine juncean can be accessed across the intranet using \\juncean\DriveD\Logbook\data.

As mentioned at the beginning of this chapter, the other seven worksheets should be left as they are.  We strongly recommend that you write protect the two example options files and take copies for customising as and when needed.

Assigning the Options File in Logbook
Once the options file has been customised we need to tell Logbook where to find it. 

· From within the Logbook Assistant click the toolbar button Output options.  The dialog box in Figure 11 appears.

· Enter the full path name of the options file into the box labelled Location of Startup options
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Figure 11 Specifying the options file in the Logbook Assistant

Note:
The options file can have any name you choose but it must be located in a folder called options which has the same parent as the publish folder.

Chapter 5 – Loading Additional Meta-data

Introduction

In the tutorial we loaded three files (two MS-Excel workbooks and one MS-Access database) that contained titles for some of the abbreviations used in the file properties.  This was also referred to at the end of Chapter 1.

Loading additional meta-data from a separate file means that we can see fuller, more meaningful titles in the published lists without having to repeat these titles in the properties for every file.

This chapter is important for type 2 and type 3 users.

Archive Property

So that the files containing the meta-data are picked up and loaded by the Logbook Assistant, they must have a property called archive set with the value of project 1.2.

Archive is a user-defined property so must be entered into the Comments field on the property sheet along with any other user-defined property you want to define.  The format should be:

Archive: project 1.2

This is shown in Figure 1 which shows the properties for the file data hierarchies.xls which is one of the files used in the tutorial.
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Figure 1: Properties of a meta-data file showing archive property under Comments 

Project 1.2 has been set as a database property on the publish.mdb database.

Note: Database properties are not the same as file properties.  Figure 2 shows the file properties of publish.mdb.  As you can see no file properties are set.
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Figure 2: File properties of publish.mdb

However, if we open the database and from within MS-Access we choose Database Properties from the File menu we are shown a different set of properties as shown in Figure 3:
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Figure 3: Database properties of publish.mdb

Here you can see Project 1.2 in the Comments field.  It is this value that must match with the value of the archive user-defined property if Logbook (and the Data publishing system) is to recognise the file as containing meta-data.

How meta-data affects the display

In the tutorial the meta-data was loaded automatically because the archive property was defined on the files and correctly set with the value project 1.2.  Figure 4 shows the Internet view of the results:

[image: image60.png]What are you looking for? Search ] Scop

View data by Strategis Flan far East & Central Africa Regianal Program

/sample

i ot by b

Vi st by Researc Acivites o0 bild cxperiments,survers, oo %
Vi st by Type of OutpuDosument

i st by Ourers fthe Dat/Document e

i dst by Gt of Resorc s Pubcaion

view data by Pragram of Work, Data Management 2005

view data by Logbook-compliant Files to Support Long-term Archiving





Figure 4: Results with meta-data loaded

If we remove the archive property from these files and re-harvest the data the results are less user-friendly as shown in Figure 5:
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Figure 5: Results without meta-data loaded

In Figure 5 the headings are taken directly from the properties: Category, Author and Keywords are some of the properties you will see on the summary tab when viewing and setting file properties; ecaplan, Year, Location, Donor and Experiment are all user-defined properties which were defined and given values in the Comments field of one or more of the files;  Folders is used by the data publishing system and provides a method to browse the physical folder structure from the results of the harvest.

In Figure 4 these single-word headings have been exchanged for more meaningful titles taken from the meta-data files.  Figures 6a and 6b show the contents of a worksheet from each of the files data hierarchies.xls and some metadata common to most projects.xls
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Figure 6a: Contents of worksheet from data hierachies.xls
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Figure 6b: Contents of worksheet from some metadata common to most projects.xls
When these files are loaded as meta-data – i.e. when we set the user-defined property archive to project 1.2 – you can see that the single-word headers are replaced by the corresponding title.  Thus ecaplan becomes Strategic Plan for East & Central Africa Regional Program, etc.

Note: The order is not the same in Figures 4 and 6 – the order is partially determined by the domain_order in Figure 6b.

Creating a worksheet of meta-data
The worksheet containing the meta-data to be loaded must be Logbook compliant.  In other words the Logbook Assistant must be able to determine where each piece of information is to be stored in the publish.mdb database.

As we have seen, the headings are determined by the properties used in the files to be published.  We discussed file properties in Chapter 1 and we know that we have Title, Subject, Author, Keywords and Category.  In addition there are the user-defined properties and we suggested having a fixed set of properties for your institution or organisation.  Data Publishing refers to the headers or properties as domains (do not confuse these with network domains which are completely different).

Note: The Title property is assumed to be different for each file so data publishing does not treat that as a domain.

Thus in Figure 6 we see the first column is headed domain.  Here you can list the properties (both pre-defined and user-defined) that you will be using.  The second column is headed domain_title and this is where you give a more user-friendly title to each property.  If a property is used on a file but is not given a title, then it will just appear in the published lists as:

View data by property

An example of this is Keywords which does not appear in Figure 6 and so appears as

View data by Keywords

in both figures 4 and 5.  An optional third column is for domain_order.  This is where you can control the order of the headers in the results.
Setting the “Orientation”

Those of you familiar with using Logbook for data management will recognise the term “orientation”.  This is a named range in the worksheet from which the Logbook Assistant can determine the correct location in the database for all the information in the worksheet.  To be Logbook Compliant a worksheet must have the orientation defined.  In the worksheets we are discussing here the orientation is the header row.  Where we have just domain and domain_title as in Figure 6a, the orientation is the range A1:B1.  Where we also have domain_order, as in Figure 6b, the orientation is A1:C1.

There are two ways to set the orientation:-

1. Select the desired range, e.g. A1:C1, then type orientation_worksheet into the Name box located to the left of the formula bar.  Worksheet should be the name of the current worksheet.  For example if your worksheet is called arms you must name the range as orientation_arms.

2. Select the desired range, then, leaving the worksheet open and the selection in place, open the Logbook Assistant and click the toolbar button Define orientation (or choose Define orientation region from the Edit menu).  This automatically names the selected range in the correct way.

Often you will see the orientation region highlighted in yellow.  This is optional but can help the user to identify the regions in the worksheet.  This is particularly useful if you are using Logbook to store your data.  See the Logbook Users’ Manual for more information.

Domain Hierarchies and Attributes

In Chapter 1 we said that we can have nested values for properties by specifying the values as 

level1\level2

Thus to define a file as being connected to a location Maseno which is within Western Kenya we could define the property as:

Location: Western Kenya\Maseno

However, if we know in advance what all our locations are and how they are nested we can use a meta-data worksheet to define them.  Figure 7 shows an example:
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Figure 7: Hierarchy of Locations in meta-data file

Cells A1 and B1 tell us that the domain (or property) we are working with is Location.  The rest of the worksheet goes on to define the attributes or values of location.  Logbook has a strict convention for determining hierarchies.  In this example we have two levels in the hierarchy as they are many locations within Western Kenya.  The lowest level in the hierarchy is called attribute with higher levels having a numeric suffix.  This in our example attribute_1 is always Western Kenya and the column containing the locations within Western Kenya is headed attribute.  If we had a higher level – Africa for example – this would be attribute_2.

In this particular example the orientation is the range B2:C2.  The Logbook Assistant then recognises the range B3:B24 as belonging to attribute_1 and C3:C24 as belonging to attribute.  Row 1 is treated as a separate region of the worksheet and from the information given the Logbook Assistant knows that these attributes are values for the domain (property) called Location.  See the Logbook Users’ Manual for a more in-depth explanation of regions of a worksheet.

Attribute Titles

In the same way that you can give titles for domain – you can also give titles for attributes.  From Chapter 1 we know that we could do this when setting the values for the properties.  This is done by using the format:

Property: value=”Title”

For example in the Category property we could set the value as:

Data=”Raw or Derived Data”

Figure 8 shows an alternative method which is incorporated into assessment hierarchies.
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Figure 8: Attribute titles

This particular example shows that Data is an attribute or value of the domain called Category.  The title for Data is found in cell C2 and is Raw or Derived Data.  Nested within Data there are 13 attributes in the cell range B4:B16.  The single cell B3 is the orientation in this example.

An alternative layout for this same meta-data is shown in Figure 9.  In this layout the orientation is the range B2:D2.
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Figure 9: Alternative layout for assessments

In this example the higher level attribute value and title is repeated for each value in the lower level.  This is similar to Figure 7 where “Western Kenya” is repeated.  As we saw in Figure 8 we can remove the repetition in the worksheet by placing the higher level attributes in the rows above the orientation.  When we move the information above the orientation the value in column A should be either “domain” or “attribute”; the value in column B is assumed to be the value of the domain or attribute; and in column C it expects the title.  Thus in Figure 8 “Raw or Derived Data” is assumed to be the title for the attribute Data.

Figure 10 shows an alternative layout for the locations from Figure 7:
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Figure 10: Alternative layout for locations removing repetition

Nested Attributes and Titles

As a final example in this chapter we consider Figure 11.  This shows two attributes – rapid and methods – for the user-defined property powb05.
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Figure 11: Nested and Titled attributes

Methods is nested within rapid.  Row 3 defines rapid as an attribute and assigns a title to it.  In row 4 we define Methods nested within rapid.  The orientation here is the range A2:C2.  Figure 12 shows this nesting in the published results:
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Figure 12: Nesting of attributes and titles

Summary

In this chapter we have see how we can set up worksheets in Excel to load titles and values for properties so that we don’t have to define them for each individual file.  We can also load meta-data from an Access database.  To do this you need to have some experience with MS-Access so the method is not covered in this manual but will be included in the Data Managers’ Guide.

Whether you have your meta-data in Excel or Access, you must have archive: project 1.2 defined in the Comments property.

Chapter 6 – Harvesting and Viewing
Introduction

So far in this manual we have shown how to set file properties, share folders, create virtual directories and customise the options file.  The final stage in data publishing is to harvest the data and view the results.

You can harvest files from several different folders either from the current machine (i.e. the machine being used for the harvesting and publishing) or from another machine on the same domain.  Remember, if you are harvesting from another machine then that machine must be switched on and the folder must be shared with adequate permissions.  The machine does not need to have anyone logged in but does need to be switched on.

Opening the Logbook Assistant

The Logbook Assistant is used to harvest the files.  The Logbook executable file is called lb.exe and is generally found in the bin sub-folder of the installation folder.  By default this would be C:\Program Files\Logbook.  If you are using Logbook frequently it is advisable to create a shortcut either on your desktop, on your Start menu, or on your Quick Launch toolbar.

· Open the Logbook Assistant by double-clicking on lb.exe or a shortcut to this file.

Setting the options file

The first task is to set the options file.  We assume you have created your virtual directories (see Chapter 3) and have customised your options file (see Chapter 4).

· On the toolbar in the Logbook Assistant click Output Options
· In the box labelled Location of Startup options enter the full pathname of the options file – remember that My Documents is actually C:\Documents and Settings\<User>\My Documents.

· Click OK
Harvesting the files

· From the ProactiveShare menu choose Pro-active Share.

Assuming all goes according to plan an Internet Explorer window should eventually open (the harvesting may take a few minutes if there are lots of folders to look through).  The Internet Explorer window will look like that shown in Figure 1:
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Figure 1: Initial Internet Explorer Window after harvesting

The actual text of the hyperlink will depend on the value for the title option given in the options sheet of the options file.

· Minimise the Internet Explorer Window and click OK on the pop-up in the Logbook Assistant.
Viewing through the Logbook Assistant

You can view the published lists through the Logbook Assistant.  On the left hand side of the screen there will be a tree structure that you can navigate.

· Click the plus sign next to Logbook on the left hand side (or double-click on Logbook) to open the tree.

Below Logbook in the tree you can view data by different characteristics.  Figure 2 shows an example:
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Figure 2: Data characteristics

The characteristics shown and the exact wording in the display are determined by the properties found on the files and any meta-data you may have loaded (see Chapter 5 for information on loading meta-data)

Below each characteristic in the tree structure you will find a list of values that have been found for that property.  Depending on how the properties have been defined, either on the property sheet of individual files, or using loaded meta-data, the values may be nested.  Figure 3 shows an example of nesting:
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Figure 3: Nested values

Clicking on any of the values will display a list of files on the right hand side that have that particular property and value combination.  

Note: some files will appear in more than one list depending on how many properties have been given values, and some lists will be empty – i.e. the value may have been set through a meta-data file but no files were found with that value.

On the right hand side there are several columns.  The first column is headed Path and this contains a unique numeric ID.  Double-clicking on this ID will open the file in the appropriate application.  The second column is the pathname of the file.  The remaining columns correspond to the different file properties and will have entries or not depending on whether values have been assigned to those properties for that particular file.  Figure 4 shows a list of protocols displayed on the right hand side of the Logbook Assistant window.
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Figure 4: File list in Logbook Assistant

Note: To open a file you must select and double-click the path ID number.  In the example in Figure 4 the first file is selected (there is a dotted line round the number 302).  Double-clicking anywhere on the right hand side of the window will open this file, even if you are pointing to another file in the list.

Viewing through Internet Explorer
A better way of viewing the file lists is through Internet Explorer.  After harvesting the data, and Internet Explorer Window is opened (see Figure 1) and this has a hyperlink taking you to the data publishing view which matches directly with the Logbook Assistant view.  The file list on the right hand side is in more of a tabular layout.  Figure 5 shows the same list of files as we saw in Figure 4:
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Figure 5: List of protocols viewed within Internet Explorer

In this table most items (apart from the file title) are hyperlinks.  Clicking a file name allows you to open the file or save it to your local machine.  Clicking on a value in one of the other property columns (e.g. on a year) will bring up a list of all files with that property value.  

Note: Authors are separated so that, even if a file has three authors, you can click on a single author to bring up a list of all files where that person is listed as an author.
Clicking on Parent folder in the penultimate column takes you to a listing of the directory containing the file.  Note this is the virtual directory linked to the shared folder and not the physical folder where the file is actually located.  Figure 6 shows an example where Data Publishing is the virtual directory on the PC with computer name snpc239.

[image: image75.png]snpc239 - /Data Publishing/Samples/Experiment
data/Coppicing expt (SE2000a2)/Bean yield/

To Parent Director:

05 January 2007 10:55 29696 SE2000a2 beanyld SRO0Z.xls
05 October 2006 15:10 25600 SE200022 beanyldSRO1.xls
05 October 2006 15:10 56320 SE200022 yld LROZ.xls

05 October 2006 15:10 24064 SE2000azbeanyieldsRO3.xls




Figure 6: Parent directory display

Clicking the Meta-data hyperlink will take you to a display of the file properties.  Figure 7 shows an example:
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Figure 7: Meta-data display

Depending on the permissions you have for the file you may be able to manually change the file properties from this screen.

· Make the change you want and then click Submit.  If the change is successful the display on the right hand side will clear and it will say OK.

Note: If you immediately try to make another property change to the same file, the update is likely to fail.  Figure 8 shows the typical message you might receive.
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Figure 8: Update to property values failed

In this situation go back to the file lists and try again.

Viewing Published data

Once you have harvested the data, you can view the published lists at any time by opening the file ViewWebSite.htm.  This will be located in the publish folder; in other words the physical folder containing the database publish.mdb.  This will have been defined as the value of the publish option on the options sheet within the options file.  For example in Figure 9 the publish folder is C:\LB-publish\publish.
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Figure 9: Options sheet showing location of publish folder

Scheduled Tasks

You can set your computer to harvest files automatically at a regular time.  This is done by using the Windows Scheduler.  For this you first need to know the command line for running Logbook together with the parameters for harvesting files.  The command you need is:

C:\Program Files\Logbook\bin\lb /proshare/<options file>
where <options files> is the full pathname of the options file.  Note: there is no space between /proshare/ and the pathname of the options file.  For example:

C:\Program Files\Logbook\bin\lb /proshare/C:\LB-publish\options\intranet options.xls

To add this to the scheduled tasks you will need administrator rights.  The method to use is:

· Go to Start -> Control Panel
· If using Category view choose Performance and Maintenance
· Choose Scheduled Tasks
· Choose Add Scheduled Task
· Click Next
· Click Browse (Logbook is unlikely to be in the default list given)

· Browse through the folders to find lb.exe under the bin sub-folder of the Logbook installation folder – normally this is C:\Program Files\Logbook
· Click Open
· Give a name for this task – e.g. Data Publishing
· Pick a frequency for this task – e.g. Monthly
· Set the start time and other parameters – e.g. the first Monday of each month at 10:00.
· Give your username and password and confirm your password.
· You still need to set the parameters so click the option for Open Advanced properties.

· Change the entry in the Run: box by adding /proshare/<options file> at the end, where <options file> is the full pathname of the options file.

· Click OK
· Again enter and confirm your password.

The harvesting should now take place automatically at the times you have specified.  Remember if you are harvesting from another machine on the network that machine must be switched on.
Publish Database


Stores meta-data from files, harvested from file properties





Logbook Database


Stores data generally loaded from Excel spreadsheets





Logbook Assistant


Used for loading “data” into the databases and for browsing data and meta-data in a user-friendly way
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